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ABSTRACT

A potential treatment of heart failure from myocardial infarction is to replace 
damaged tissue with a cardiac patch, a bioengineered construct of cardiomyocytes 
and stem cell-supported capillaries grown on a bioscaffold. Tissue engineers 
must have a thorough understanding of the cues that guide multiple cell types to 
form functional tissue. As the field of cardiac tissue regeneration develops novel 
protocols for stem cell-based therapies, visualizations that didactically convey in vitro 
spatiotemporal cell-cell interactions become increasingly important to provide to 
students and the general scientific community.

An interactive web-based animation and educational module, Stem Cell Orchestra, 
was designed and developed to introduce students to case-based examples of 
biomedical research that are directly related to fundamental tissue engineering 
principles. A conceptual flowchart was created to establish the navigational structure 
of the module and connections between educational topics. The module focused 
on visualizing the development of a cardiac patch as a model bioengineered tissue 
through the creation of a 3D animation depicting cell-cell interactions within 
a cardiac patch. Animation content was derived from confocal microscopy and 
transmitted light microscopy datasets in combination with the results of a literature 
review of current cardiac regenerative medicine techniques. The educational module 
presents the 3D animation within the context of supplemental educational material 
on mechanotransduction cues related to cardiac patch development. 

This interactive animation platform introduces students to examples of primary 
research and accurately showcases tri-culture of a cardiac patch from cardiomyocyte 
elongation and synchronization to the formation of endothelial capillaries supported 
by the novel human adipose derived stem cells. Supplemental material contextualizes 
mechanotransduction presented within the animation. This project resulted in the 
development of a novel workflow and educational module that can be expanded to 
include additional tissue engineering concepts.

Shawna Snyder
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INTRODUCTION

Engineering Tissue for the Heart
The heart myocardium is the thick layer of muscle in the walls of both atria and 

ventricles. It is composed primarily of contractile cardiomyocytes. The myocardium 
has limited regenerative potential after an injury such as myocardial infarction (MI), 
which induces formation of scar tissue. This area of scar tissue has no contractile 
ability and often contributes to heart failure that typically occurs within five years 
of an MI event (Mather 2016, Radisic 2016, Stoppel 2016). Current heart failure 
treatments include heart transplantation, drug therapy, and left ventricular assist 
devices. The limitations of these therapies spurred the development of alternative 
treatments that include replacement of the damaged vasculature and cellular 
microenvironment (Radisic, 2016, Parsa, 2016).

Replacement of damaged native myocardium could be achieved with a tissue-
engineered construct called a cardiac patch (Iyer 2008, Lesman 2010, Mather 2016, 
Menasche 2015). Successful integration into native heart tissue requires that the 
cardiac patch be viable, non-immunogenic capable of electrical impulse propagation, 
and synced rhythmic contraction (Liau, 2011) with a robust vascular network 
(Lesman 2010, Sun 2016) (Figure 1). 

Smaller tissue constructs designed for the skin, cartilage, or cornea, rely 
on oxygen diffusion from native vascularization after implantation, with a 
maximum distance of 100-200 μm from cell to capillary (Novosel, 2011). 
However, cardiomyocytes are metabolically demanding within tissue constructs. 
Prevascularization strategies for thick tissue constructs are being developed to 
address high in vivo metabolic demand and prevent ischemia and cell death (Lesman, 
2010). These strategies require simultaneous cultivation of lineage-specific cell types, 
prompting deeper research into the role of physical stimuli in cell differentiation. 
To create a functional vascularized cardiac patch, cell lineage specificity is directed 
through carefully orchestrated spatiotemporal cues and cell-cell interactions (Choi 
2010, Iyer 2008, Morrissette-McAlmon 2017)
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Figure 1. Components of a cardiac patch. (A) Heart with cardiac patch applied over area of 
myocardial infarction. (B) Cardiac patch components expanded for examination. (C) Cardiac patch 
cellular microenvironment on the fibrin bioscaffold.
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Cell Types in the Native Myocardium
It is necessary to first understand the anatomical and physiological conditions 

of native myocardium in order to prepare in vitro cardiomyocytes for in vivo stresses 
(Mather, 2016). While cardiomyocytes represent the bulk of the myocardium, 
constituting ~75% of total heart volume, their number accounts for <40% of 
all heart cells, the majority being highly adaptive supporting cell types, such as 
fibroblasts, circulating blood cells, vascular smooth muscle cells, and endothelial cells 
(Figure 2). These additional cells are critical for supporting the tissue architecture 
that delivers oxygen to the energetically demanding cardiomyocytes.

Cardiomyocytes

Native heart tissue contracts 60-100 times per minute, enduring contractile 
stresses of 15-30 kiloPascals (kPa). Only 1% of cardiomyocytes control the electrical 
conduction rate that signals contraction; the rest are triggered to contract via gap 
junctions and voltage-gated ion channels that control internal and external ion levels 
(Stoppel, 2016). 

Figure 2. Conceptual illustration of the native heart microenvironment. Pericytes stabilize 
endothelial cells, which constitute the walls of capillaries. Fibroblasts secrete collagen, which aligns 
cardiomyocytes into a parallel configuration and provides structural support.

Pericyte

Endothelial Cell of Capillary

Cardiomyocyte

Fibroblast Cell
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Cardiomyocytes do not regenerate, but the heart does undergo periods of growth 
due to age-related mechanical stimuli. This suggests that cardiomyocytes are capable 
of undergoing local changes in size (e.g. hypertrophy) in response to external 
forces. Phenotypic cardiomyocyte change is guided by the native heart extracellular 
matrix (ECM), which is primarily constructed of perimysial collagen fibers (~0.5-
10 μm in diameter). The cardiomyocytes interact with collagen fibers through 
various mechanotransduction pathways (Parsa, 2016, Mather, 2016) that, early in 
development, pack the cells into a parallel-oriented alignment. Cardiomyocytes sense 
differences in substrate stiffness through integrin binding, receptor tyrosine kinase 
activation, and GTPase activation at the cell membrane, which affects cell-signaling 
pathways. This is an adaptive, temporal process that allows cells to induce transient 
or permanent tissue modifications, and ultimately determines cell fate decisions 
(van Helvert, 2018). Understanding the development and architecture of native heart 
tissue is critical for constructing a bioscaffold on which to grow cardiomyocytes and 
capitalize on the physical constraints that regulate heart tissue at the microscale.

Endothelial Cells

Endothelial cells form the inner layer of blood vessels. They are generally 
thin and slightly elongated, and in the heart, contribute greatly to cardiovascular 
homeostasis. In healthy heart tissue, the endothelium is the principle regulator 
of vascular permeability, blood vessel caliber, and cell transport to and from 
the bloodstream. Through the expression, activation and release of vasoactive 
and bioactive molecules (Brutsaert, 2003), endothelial cells communicate with 
cardiomyocytes to regulate contraction. When cultured with endothelial cells, 
cardiomyocytes align along the outside of the developing capillaries, form gap 
junctions, and help coordinate contraction (Hsieh, 2006). 

Mural Cells

Mural cells such as pericytes and smooth muscle cells stabilize thin-walled 
capillaries. Endothelial cells actively recruit pericytes to the outside of growing 
multicellular cords during angiogenesis and vasculogenesis. The pericytes adhere and 
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differentiate to form the outside of the new capillary. In cellular culture, however, 
mural cell use is limited due to an inability to obtain adequate cell numbers for 
induced pluripotent stem cell therapies (Merfeld-Clauss, 2010).

Fibroblast Cells 

Fibroblasts are found throughout cardiac tissue, surrounding the cells and 
bridging the gaps between myocardial tissue layers. They synthesize many of the 
extracellular matrix proteins found in the heart, including collagen, which maintains 
tissue architecture during ventricular contraction and relaxation (Dostal, 2001).

Human Adipose-Derived Stem Cells in Tissue Engineering 
Widely used in tissue engineering applications, human adipose-derived stem cells 

(hASCs) are a clinically available source of stem cells and endothelial progenitor 
cells (Hutton, 2015). Stem cells are undifferentiated cells that have multilineage 
potential, long-term viability and great potential for self-renewal. In adipose tissue, 
hASCs are predominantly localized to the periendothelial layer of capillaries and 
are both phenotypically and functionally equivalent to capillary pericytes (Merfeld-
Clauss, 2010). When attached to a substrate in vitro, hASCs display a spindle-
shaped morphology and lack the intracellular lipid droplets found in adipocytes. In 
comparison with bone marrow-derived mesenchymal stem cells, hASCs show higher 
collagen production and are more stable in long-term cultures, with lower cell death 
and higher proliferation capacities (Frese 2016). 

When cultured with endothelial cells, hASCs guide the self-assembly of 
endothelial-derived vascular networks (Hutton, 2015), express functional properties 
of pericytes, and establish multilayered functional vessels (Merfeld-Clauss, 2010), 
which may accelerate tissue construct vascularization in vivo rather than having to 
rely solely on angiogenic ingrowth from native myocardium (Hutton, 2015). Factors 
secreted by hASCs, such as vascular endothelial growth factor (VEGF), basic 
fibroblast growth factor (bFGF) and angiogenin, promote endothelial cell survival 
and multicellular cord formation. In co-culture with endothelial cells, hASCs secrete 
extracellular matrix proteins (Merfeld-Clauss, 2010) and enable endothelial cells 
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to form 3D vascular networks, even in hypoxic environments, such as those likely 
to be encountered after implantation before the integration of host vasculature. 
Additionally, when cultured together with endothelial cells and cardiomyocytes, 
hASCs may integrate with cardiomyocytes and possibly contribute to contraction 
(data unpublished, Morrissette-McAlmon, 2018). The minimally invasive method 
of harvest, simple isolation procedure, and great potential for self-renewal means 
hASCs could hold great promise for future cell-based therapies.

Building a Cardiac Patch
At the Grayson Lab for Craniofacial and Orthopaedic Tissue Engineering, 

a vascularized cardiac patch was created on fibrin microfiber sheets utilizing a 
cellular tri-culture approach. Three cell types were selected: neonatal rat ventricular 
cardiomyocytes (NRVCMs), hASCs, and human vein umbilical endothelial cells 
(HUVECs). Tri-culturing of NRVCM:hASC:HUVEC, with the optimal ratio of 
1500:37.5:150, resulted in robust vascular network formation with cardiomyocytes 
retaining conduction velocities and action potential durations similar to NRVCM-
only experiments (data unpublished, Morrissette-McAlmon 2018). 

Fibrin microfiber sheets are produced through electrospinning (Figure 3), which 
uses electric force to draw charged threads out of polymer solution to create tunable 
fiber diameters. Electrospun fibrin microfiber sheets were used to provide alignment 
cues to guide cardiomyocyte elongation. 

Fibrin microfiber sheets of two different stiffness values were used. Fibrinogen 
concentration of the solution, concentrations of calcium and thrombin of the 
collection bath, and the rotational speed of the bath all impact fibrin microfiber sheet 
stiffness. 

During electrospinning of a fibrin microfiber sheet, a thread of fibrinogen 
hyrdogel is ejected from an syringe and onto a rotating collection wheel to form a 
crosslinked disc of parallel fibrin threads. To begin, the collection wheel is set to a 
speed of ~45 RPM and 50 mL of collection solution (20 U/ml thrombin to 50 mM 
CaCl2) is added to the outside rim of the wheel. This creates a band of liquid on 
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the outer margins of the rotating plate with no liquid in the center of the collection 
wheel. With the ground (negative) electrode propped against the underside of the 
rotating collection wheel, the syringe containing 5 mL of fibrinogen hydrogel is 
loaded into the syringe pump and set to dispense (5.0 ml/hr). The syringe pump is 
set on a linear stage (~3 cm/min over 1.5 cm) and the syringe needle tip (positive 
electrode) is placed over the collection wheel. The fibrinogen thread is pumped out 
and onto the collection wheel after the activation of the power supply (4.5 kV). 

After 17-20 minutes, the power is shut off and the fibrin sheet sits for an 
additional 2 minutes in the collection bath to ensure full crosslinkage of the 
microfibers. After being wrapped around a Mylar frame (1 cm x 1 cm), the resulting 
fibrin bioscaffold is 300-500 microns thick.

The cardiomyocytes (suspended in NRVC media), are seeded onto the fibrin 

Figure 3. Electrospinning of a fibrin microfiber sheet. The syringe dispenses a thread of 
fibrinogen hydrogel which crosslinks into fibrin when it lands in the collection solution. The 
collection wheel rotates as the syringe moves back and forth, forming a thin sheet of parallel fibrin 
on the surface of the collection solution.

Collection Solution
Syringe

Needle tip

Stage

Collection Wheel

+

–
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bioscaffold at 1.5 x 106 cells/cm2. They immediately begin to attach to the substrate 
and Aprotinin (10%) supplemented into the media prevents the cardiomyocytes from 
eroding the fibrin bioscaffold. Washed with NRVCM media containing Aprotinin 
every other day, the cells align into a parallel configuration due to the topographical 
properties of the fibrin bioscaffold. Spontaneous contraction begins four to seven 
days after seeding. After thirteen days, mature intercalated discs form at the 
endplates of touching cardiomyocytes, and gap junctions between the neighboring 
cardiomyocytes in the cell sheet promote synchronized contraction.

Fourteen days after cardiomyocyte seeding, hASCs and HUVECS (3.7 x 104 
hASC/cm2 and 1.5 x 105 HUVEC/cm2 in 20 μL of media) with an optimized 
composition are added to the fibrin bioscaffold. All the cells are nourished with tri-
culture media (3mL). The media is refreshed every other day as the endothelial cells 
elongate and begin to form multicellular cords. During this time, the hASCs migrate 
and cluster around the multicellular cords as the cords fuse into a capillary network. 
The cords become stabilized from the hASCs and the vascularized myocardial tissue 
can remain in culture for up to two months (Figure 4).

The survival, morphology and 
electrophysiological and contractile 
properties of cardiomyocytes on 
these fibers were described and it was 
found that (1) cardiomyocytes formed 
gap junctions and developed mature 
electrophysiological parameters, (2) 
culture of hASCs and endothelial cells 
resulted in dense capillary networks, 
and (3) fibrin microfiber sheets may 
serve as a suitable bioscaffold on which 
to grow a functional vascularized 
cardiac patch (data unpublished, 
Morrissette-McAlmon et al., 2018).

Figure 4. Confocal microscopy data of tri-
cultured cardiac patch. Red channel shows 
mature, aligned cardiomyocytes, green channel 
shows endothelial cells. Data unpublished, 
Morrissette-McAlmon et al. 2018
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Current teaching materials for tissue engineering
At Johns Hopkins University School of Medicine, the course Principles of Tissue 

Engineering is offered to senior undergraduate and first-year Masters, PhD and MD/
PhD students by Dr. Warren Grayson. The course covers topics relevant to the field 
of tissue engineering, including cellular structure development and function and is 
intended to introduce students to applications of fundamental engineering concepts 
for the design of biological tissue substitutes. The information is presented in several 
ways, including text, photography, tables, graphs, SEM images, confocal microscopy 
images and 2D illustrations.

Informal discussion with student consultants at the initial stage of this project 
informed the content design and objectives of the educational material. In addition, 
detailed review and critique of the course materials identified areas that could benefit 
from the creation of visual didactic materials. While some course content included 
lectures with dynamic visual displays of data and case examples of current research, 
the following limitations to the current educational materials were identified.

First, the majority of cellular events presented in lecture are captured and 
displayed through confocal microscopy. Confocal microscopy is an optical imaging 
technique for capturing microscopic assemblies by illuminating specific structures 
tagged with immunofluorescent antibodies. By capturing multiple 2-dimensional 
images at different depths in an organic sample, a three-dimensional (3D) volume 
of a specimen can be reconstructed. Limitations to these visualizations included the 
fact that (i) not all cells or structures are antibody-tagged, which leaves cut-out dark 
shapes where untagged cells reside, (ii) cellular bioscaffolds are not targeted, so 3D 
bioscaffolds appear as a negative space and 2D bioscaffolds do not appear at all. 

Additionally, cellular bioscaffolds are only visualized through scanning electron 
microscopy (SEM). SEM visualization is restricted to the outermost material and 
in multi-layer tissue constructs, the deeper layers of tissue remain inscrutable. They 
indicated that the individual visualizations of each component of bioengineered 
tissues make it difficult to conceptualize the cellular microenvironment as a whole.
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Cellular motion cannot be captured through immunofluorescent imaging as 
cells are fixed (dead) during the visualization process. Rather, cellular motion is 
generalized by capturing cells in different stages of development over an interval 
of time and presented in a multipart sequence. The intricacies of cellular motion 
throughout each stage of tissue culture are not captured through other means.

Course lectures contained few 3D structures. Volumetric reconstructions were 
used to visualize cells in multi-layer constructs and alignment in relation to a 3D 
bioscaffold, which can appear as a negative space in immunofluorescent imaging. 
However, in 2D bioscaffold cell culture, there is no negative space as the cells 
are grown into a confluence on top of the bioscaffold. When shown in lecture, it 
can be difficult to convey the intricacies of 2D physical stimuli with volumetric 
reconstructions alone. 

As a result of the course content review and informal discussions, it was 
determined that the course would benefit from the inclusion of more bioengineering 
data presented in a visual way to show the complexity of a system or tissue and 
that more specific examples of bioengineering research would provide engaging and 
memorable ways to learn new content and help students decide in which lab they 
would like to work.

Understanding cellular microenvironment dynamics is critical for every step of 
successfully culturing multiple cell types together. Although there are many reliable 
techniques to visualize in vitro cellular culture, these techniques fail to convey the 
intricacies when three different cell types are cultured together. Because cardiac 
tissue engineering is an evolving discipline, audiences such as students and the 
general scientific community may have difficulty interpreting novel research results 
and integrating raw data into an accurate representation for educational purposes. 
Multiple audiences could benefit greatly from the development of a didactic, 
interactive 3D animation-based module that utilizes novel data to visualize and teach 
tissue-engineered principles.
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Interactive Media in Biomedical Engineering
Bioengineering students are introduced to the complex fundamental processes 

that guide stem cell fate in lectures before they experience lab work. However, 
because cardiac tissue engineering is a rapidly emerging field (Radisic, 2016), visuals 
of the intricacies of organized in vitro cardiac cell interactions and tissue growth are 
extremely limited. In addition, raw datasets do not show all of the cell types and 
structures within a cardiac patch simultaneously, making intricate cellular activity 
difficult to visualize for novice students. 

As students working towards their degree may require flexibility for scheduling 
learning activities, educational formats are being developed to accommodate 
a variety of teaching and learning styles (Caron 2015). Supplementary online 
educational formats offer students a range of learning opportunities outside the 
classroom. Learners can have increased control over the content and pace of 
information presentation and view educational materials independently (Kalyuga 
2015). For bioengineering students with a focus on tissue engineering, access to 
novel interactive animations integrated into an online learning module could be 
used to connect real-world laboratory research with examples of fundamental 
tissue-engineering principles. This resource could serve to guide students through 
visual case-based research examples that integrate different research datasets into 
comprehensive teaching visualizations.

Learning Theories

Cognitive load theory suggests that learning happens best under conditions 
aligned with the learner’s cognitive architecture. New information is stored in short 
term memory, which is limited in the number of elements it can hold simultaneously. 
Learning materials that reduce working memory in learners should be designed by 
(1) physically placing sources of information together (e.g. labels near structures 
they define) (2) reducing unnecessarily repetitive information and (3) cueing visual 
and auditory information simultaneously (Sweller 1999). In scientific animation, 
these principles can be utilized to reduce extraneous cognitive load imposed by the 
attentional requirements of processing relevant elements (Amadieu F 2011).
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Objectives
This project focused on visualization of the development of a cardiac patch as a 

model bioengineered tissue through the following objectives:

1. Design a web-based platform that contextualizes fundamental tissue 
engineering principles and techniques with examples of laboratory research. 

2. Create didactic 2D and 3D animations of the cardiac patch building process 
with supplemental interactive 3D models and learning materials accessible 
from the animation timeline that allow users to study cellular interactions and 
environmental cues. 

3. Using 3D models built from segmented data, the interactive animations will:

a. Visualize external and internal forces that drive cellular interactions 
and impulse conduction between cardiomyocytes. 

b. Communicate biophysical and mechanotransduction principles of 
substrate-cell interactions and cell-cell interactions of cardiomyocytes, 
endothelial cells, and hASCs.

Audience
The primary audience for this interactive animation and website is biomedical 

engineering undergraduates and graduate students specializing in tissue engineering. 
The secondary audience is professional biomedical engineers and biologists working 
in related research areas. 
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MATERIALS AND METHODS

Software Overview
A range of software was utilized to create art assets and final animations for this 

project. Fiji (Fiji is Just ImageJ)® and Imaris® from Bitplane were used to segment 
tri-culture cardiac patch and cardiac cell t-tubule confocal microscopy datasets to 
create surface meshes and analyze 3D volumetric renderings of the supplemental 
cardiomyocytes. Meshlab® was used to remove artifacts and decimate surface 
meshes. ZBrush® from Pixologic was used to optimize the segmented meshes, 
sculpt, and create new models for the 3D animation. Cinema 4D® and Adobe 
After Effects® were used to create and render 3D scenes and assemble the 3D 
animation. Storyboards and additional pieces of content were created with Adobe 
Photoshop®, Adobe Illustrator®, and Procreate® for Apple iPad. TouchCast® Studio 
with Webinar and Livestream was used to compose the final interactive animation. 
Wordpress® was used to create the Stem Cell Orchestra website.

Content Aggregation 
All materials related to cell adhesion, mechanotransduction, and vascularization 

that are taught in the graduate course Principles of Tissue Engineering were studied in 
preparation for design of the website and animation. Information from peer-reviewed 
research articles was gathered to assess current methods of growing a cardiac patch, 
and information on the cellular microenvironment was gathered from cellular 
biology and histological textbooks. 

The hierarchy of information to be presented on the website was developed from 
conversations with the project preceptor, Dr. Warren Grayson. The website content 
was further organized through the aforementioned informal discussions with 
students. A series of questions (Appendix A) was utilized to guide discussions and 
specific educational goals were defined and prioritized.

An outline of fundamental tissue engineering subjects and educational topics 
to be included in the website was created. The following topics in the course were 
identified as critical learning goals: (1) Stem Cell Differentiation (2) Tissue Structure 



14

and Function – Native and Engineered (3) Cellular Adhesion and Mechanobiology 
(4) Bioscaffold – construction and application (5) Vasculogenesis and (6) 
Transplantation of Large Tissue Constructs.

Of the current biological areas of interest in regenerative medicine, Heart Muscle 
was chosen as the primary subject to develop as a prototypical pathway for the 
entire website. The information hierarchy for the Heart Muscle section was developed 
and revised with feedback from the student consultants. Development of a cardiac 
patch was chosen to serve as a real-world example of laboratory research and a 
model for bioengineered tissue to be visualized. Learning topics were identified to 
link the web-based content in the Heart Muscle section with the laboratory research 
visualization entitled, Building a Cardiac Patch. A conceptual flowchart was created 
to establish the navigational structure of the website and interlinkage between 
educational topics and the cardiac patch visualization. The flowchart was modified 
based on consultant feedback.

Script and Storyboard Development
For the cardiac patch visualization, a script (Appendix B) was created based 

off the defined educational topics and unpublished data on cardiac patch tri-culture 
provided by the Warren Grayson Lab. Time points for user interactivity were 
identified within the script. A detailed animation timeline with points of interactivity 
was then created based on the previously outlined goals to match the interactivity of 
the website flowchart. Aforementioned principles derived from cognitive load theory 
(Sweller 1999) were applied to the animation design in order to reduce extraneous 
cognitive load.

Interactive media from the Heart Muscle webpage relevant to the module, Building 

a Cardiac Patch, was chosen for development as a complete educational module with 
interactive animation. These areas were indicated by numerals within the flowchart. 

Storyboards for the selected educational module and interactive animation were 
created to reflect the topics outlined in the website flowchart and the user interface 
was designed. Iterative student feedback was used to revise website storyboards.
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Data Visualization

Datasets Utilized

Confocal microscopy datasets of tri-culture (NRVCM:hASC:HUEVC) cells were 
provided by the Grayson Lab for Craniofacial and Orthopaedic Tissue Engineering. 
These datasets contained stacks of two-dimensional images captured on a Zeiss LSM 
510 Meta confocal microscope using a 5x or 20x objective lens. The .lsm file format 
was used for storage of each set of confocal data. 

Bill Louch and Michael Frisk of the Louch Lab at Oslo University Hospital 
provided an additional dataset (.lsm and .tif) of a single cardiomyocyte cultured on a 
hard substrate, captured with a 63x objective lens. 

Molly Maleckar and the Assay Development team at the Allen Institute for Cell 
Science provided three additional datasets of live cardiomyocytes (transmitted light 
microscopy) with a 40x objective lens and fixed, immature induced pluripotent stem 
cell (iPS) cardiomyocytes (.tif) with a 63x objective lens. 

 Of the available datasets, seven (Table 1) were selected to use as visualization 
aids that show optimal cardiomyocyte and capillary characteristics.

#-# Source Objective Structures Width x Height x Depth

1-1 Grayson Lab 5x Vascular Channels 1800 x 1800µm x 8 images

1-2 Grayson Lab 20x Vascular Channels Tri-culture 450 x 450µm x 8 images

1-3 Grayson Lab 5x Cardiomyocyte Tri-culture 450 x 450µm x 15 images

1-4 Grayson Lab 20x Cardiomyocyte Tri-culture 450 x 450µm x 36 images

2-1 Louch Lab 63x Isolated Cardiomyocyte and 
T-tubule data

111.87 x 55.93µm x 188-197 
images

3-1 Allen Institute for 
Cell Science

63x Isolated Immature iPS 
Cardiomyocytes

153.17 x 144.05µm x 225 
images

3-2 Allen Institute for 
Cell Science

40x Contracting Immature iPS 
Cardiomyocytes

250x176µm x 120 images

Table 1. Selected datasets used as visual references throughout the entirety of the project.
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Review of Literature

A table of relevant measurements (Table 2) was compiled from a review of 
the literature, which included vessel diameter and length of neovascularization in 
a tri-cultured cardiac patch, and cellular tri-culture dimensions before and after 
seeding onto a bioscaffold. These measurements were used to inform the creation 
of the reference illustrations and 3D models including cardiomyocytes, hASCs and 
endothelial cells upon seeding, during temporal cellular change, and after growth.

Mesh Creation & Optimization

FIJI was used to view the datasets and create surface meshes that informed 
3D model sculpting. To create a 3D model of a sheet of cardiomyocytes that were 
aligned from external bioscaffold cues, #1-4 (Table 1) cardiomyocyte tri-culture 
data was used. In this dataset, two antibodies were used to label cardiomyocytes 
and endothelial cells. Cardiomyocytes were visualized in the red channel (cardiac 
troponin 1), and endothelial cells visualized in the green channel (CD31) (Figure 
5). To isolate the cardiomyocyte channel, the file channels were split using 
Image>Color>Split Channels. Binarization of the red channel was performed 
using Process>Binary>Make Binary (Figure 6) in order to divide the fluorescent 
data from the background. A 3D volume rendering was made using Plugins>3D 
viewer with the pre-selected settings (Figure 7). In the FIJI 3D Viewer, the volume 
rendering was then converted into a surface mesh by selecting Edit>Display 
as>Surface, and exporting the surface mesh, File>Export surfaces>STL(ASCII). 
This process was also used for additional capillary networks (datasets #1-1, #1-2) and 
cardiomyocyte dataset (#1-3) (Table 1).

Component Before Seeding 14-21 days after culture

NRVCM 10µm 8-13µm diameter, 55-64µm length

hASC 20µm 100µm length

Endothelial Cell 10µm 126-145µm length

Endothelial Cord -- 12-14µm diameter, 45-126 mm length

Table 2. Measurements of cellular elongation gathered from the aforementioned datasets.
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Figure 5. Confocal microscopy of tri-culture datasets. (A) Cardiomyocyte channel, cardiac 
troponin 1. (B) Endothelial cords, CD31.

A B

Figure 6. Binarization settings for removal of 
background.

The confocal microscopy datasets 
were imported into Imaris for Bitplane 
for semi-manual and automatic 
segmentation. Automatic surface creation 
began by selecting the Surfaces button in 
the navigational menu and following the 
creation wizard. After the surface mesh 
was created, it was exported to VRML 
(Virtual Reality Modeling Language) 
format, Surpass>Export selected object 
to vrml, for further optimization. 

The exported surface mesh 
of the vascular channels (dataset #1-1) was then decimated by applying 
Filters>Remeshing, Simplification and Reconstruction>Quadric Edge 
Collapse Decimation (Figure 8) in the software Meshlab. Additional processing, 
Filter>Cleaning and Repairing>Remove isolated pieces, was performed to 
remove unwanted unattached mesh data.
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 Reference Drawings for Model Creation

Cell measurements were acquired 
from confocal microscopy datasets 
(dataset #2-1) using FIJI. These 
measurements were used to guide the 
creation of the initial 3D models of 
cardiomyocytes and capillaries.

Using dataset #1-3 (Table 1), 
an illustration was created that 
guided the creation of a continuous 
cardiomyocyte sheet. The illustration 
was created in Procreate on the Apple 
iPad, and then imported into ZBrush where it was projected onto the background 
plane and used as a reference image for sculpting and refining the 3D models into a 
connected cardiomyocyte sheet. 

Data-Derived 3D Assets
Surface meshes exported from MeshLab were imported into a new ZBrush file 

as a subtool. The subtool was duplicated, renamed, and hidden to preserve a high 
resolution, unaltered reference surface mesh. All models in ZBrush were sent to 
Cinema 4D using the Tools>GoZ plugin. Cinema 4D models were often refined in 
ZBrush using the Script>Manager>Go FromCinema4DToZBrush plugin.

Cardiomyocyte Models

A Cylinder subtool was appended into a new ZBrush workspace with an 
illustration of the cardiomyocyte sheet loaded into the background. The Scale and 
Move tools were used to manipulate the Cylinder to roughly the same size as a 
cardiomyocyte cell body in the illustration. The cylinder was duplicated. With the 
new cylinder as a base, the CurveTube brush was selected from the Brush palette 
and used to sculpt the branches extending from the cylinder. These were matched 
to the underlying drawing. With the CurveTube spline activated and editable, the 

Figure 7. FIJI 3D Viewer settings.
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Figure 8. Decimated capillary network (dataset #1-1) in 
Meshlab. Text not intended to be read.

Draw Size was used to control the diameter of the tube. Adjustment of the Draw 
Size and manipulation of the CurveTube spline when in Edit Mode was used to 
form the base of a cardiomyocyte. By pressing Ctrl and clicking to exit the spline 
edit mode, a second press of Ctrl and click merged the CurveTube mesh with the 
cylinder mesh to allow sculpting with other brushes. These methods were repeated 
to approximate the other cell bodies of the cardiomyocyte and then to create a sheet 
of cardiomyocytes. The Smooth, Move Topological, and Inflate brushes were used 
to manipulate the cardiomyocyte models. 

The main cardiomyocyte was partially sculpted from 3D t-tubule data from the 
Louch Lab data (#2-1). In FIJI, a 3D surface mesh of t-tubule data was created as 
described above and imported into a new ZBrush file (Tool>Import). A new subtool 
was appended into the file and sculpted to overlap the t-tubule surface mesh (Figure 
9). The CurveTube brush was used to further sculpt branches onto this mesh and to 
edit the model, which was fit into the cardiomyocyte sheet. 



20

Capillary Bed Model

Further optimization of the capillary surface mesh was done in ZBrush. 
Undifferentiated (round) cells that remained attached to the endothelial vessel 
networks were removed. Artefacts and missing areas of data were extrapolated by 
using the CurveTube brush to approximate areas of the missing mesh components. 

Sculpted 3D Assets

Human Adipose Derived Stem Cell Models

As there was no confocal microscopy data available on the appearance of 
the hASCs in tri-culture of the cardiac patch, they were created de novo based 
on measurements (Table 2), images found in the literature (Hutton, 2015), and 
discussions with the project preceptor. In Cinema 4D, a Sphere object was created 
and in the Object panel, the radius was reduced to 90, the Segments increased to 

Figure 9. Cardiomyocyte visual reference. (A) Confocal microscopy of single cardiomyocyte (Frisk 
et al., AJP Heart and Circ, 2014). (B) Cardiomyocyte reconstruction in ZBrush.

A

B
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55, and Type set to Icosahedron. For those that were to be Pose Morph animated, 
the object was changed from Parametric to Editable.

 Capillary Growth Model

The capillaries used in the cellular scene (Figure 10) were created de novo yet 
highly informed by the data segmentation. By selecting Enable Snap>Vertex Snap 
and Create>Spline>Sketch in Cinema 4D, a spline was created that draped over 
the cardiomyocytes and onto the fibrin bioscaffold. Other splines were drawn to 
create an accurately vascularized field of capillaries no more than 200 µm from any 
cardiomyocyte. 

The two splines were paired with a Circle (Create>Spline>Circle), duplicated, 
and placed under a Sweep Generator (Create>Generators>Sweep). The sweep 
was then transformed into a polygon object by using the Object>Current State to 
Object function. The generated child objects were then connected to create a single 
object (Object>Connect Objects+Delete). Further surface details were sculpted by 
sending the model to ZBrush using the GoFromCinema4DToZBrush plugin.

Figure 10. Storyboard # 38, capillary within cellular scene.
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Figure 11. Lumenization effect I. Random effector applied to Cloner object following spline.

Figure 12. Lumenization effect II. Metaball Object applied over randomized cloner object.
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In Cinema 4D, the duplicated splines were used to create the lumenization 
effect. A Sphere object (Create>Object>Sphere) was created and placed under 
a Cloner Object (MoGraph>Cloner) which was set to Object Mode. The 
spline was then dragged into the Cloner Object field. The Distribution was 
set to Step, step set to 11, and Offset Variation to 5%. A Random Effector 
(MoGraph>Effector>Random) was created and made a parent of the Cloner 
(Figure 11). Lastly, a Metaball Object (Create>Modeling>Metaball) was made 
the parent of the Random Effector (Figure 12). The Editor Subdivision was 
lowered to 2 cm. A Metaball tag was applied to the sphere object (Tags>Cinema 
4D Tags>Metaball) and the radius set to 16 cm. 

Endothelial Cells

As three individual endothelial cells were needed (Figure 13) in order to depict 
capillary growth, a new Sphere object was created, the radius was reduced to 50, the 
Segments increased to 44, and Type set to Icosahedron. Models of the endothelial 
cell elongation were created in ZBrush. The capillary growth model mesh, created as 
described above, was used as a reference to align the position of the endothelial cells.

Figure 13. Storyboard #36. Main endothelial cells to teach elongation.
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Fibrin Bioscaffold Creation

The fibrin bioscaffold, on which the cellular interactions take place, was created 
in Cinema 4D. A SEM image of a 
2D fibrin bioscaffold microfiber 
sheet was used for reference 
(Figure 14). A plane object 
(Object>Width segments = 
50, Height segments = 124) 
was created and then a Displacer 
deformer was applied. In the 
Displacer, Object Height channel 
was set to 10 cm, and a Noise 
layer was created. 

A Smoothing deformer was 
created, Stiffness was set to 
75%, and then the Displacer–
Plane tree was made a child of the Smoothing deformer. This relaxed points that 
overlapped on the plane as a result of the noise in the Displacer Shader channel. 

The object tree was converted into an editable object and further sculpted in 
Cinema 4D and ZBrush. Once the cardiomyocyte models were in place, the Grab 
brush, set between 100-200 width, was used to raise and lower individual pieces of 
the fibrin microfiber sheet mesh, to make the cardiomyocytes appear to be lying on 
the surface.

Macro Cardiac Patch Components

The capillary mesh from the tri-culture confocal microscopy dataset was 
imported as an .obj into a new Cinema 4D file. As the microscopy resolution was 
1800 x 1800 µm, the capillary sheet was scaled to 1800 x 1800 cm for easy future 
scaling by powers of 10. Two cubes were created, aligned to the capillary object and 
scaled to represent the cardiomyocyte layer and fibrin bioscaffold layer. 

Figure 14. SEM reference of fibrin microfiber sheet. 
Text not intended to be read.
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Creation of 3D Cellular Scenes

Animating Cell Growth and Contraction

Cinema 4D was used to animate the cellular interaction scenes. To sculpt the 
different stages of growth of the cardiomyocytes, endothelial cells, and hASCs, 
models of each stage were first created based off of the storyboards. 

The Pose Morph tag was used to create smooth animated transitions between 
each stage of cell growth. The Pose Morph tag was applied to a given stage of a cell 
model. From that model, additional poses and meshes were created, edited with 
Cinema 4D sculpting tools, and animated by adjusting strength of deformation of 
desired parameters (Point, Position, etc.) The Pose Morph tag only functions when 
meshes in the Pose Morph tree have the exact same number of points. For the 
cellular models with complex geometry (e.g. cardiomyocytes), a model with a high 
point count was first created and then smoothed for transitions to simple models. 
For the cellular models with simplified geometry (ex. hASCs), an editable sphere was 
used and posed as the sphere moved along an animated path. 

To pose morph cellular adherence, the Pose Morph tag was applied, “Points” 
selected in the Basics tab, and the mesh was manipulated with Cinema 4D sculpting 
brushes (Sculpt>Brushes>Grab) to give the appearance of attachment to the fibrin 
bioscaffold. For the animation of cellular adherence, the “Animate” tab was selected, 
the sliders adjusted and then the models were keyframed. 

Next, the high-polygon count models were given Pose Morph tags and, working 
in reverse of the animation timeline, were sculpted into simpler forms for each stage 
of the animation. As each mesh had to be carefully manipulated from one step in 
elongation to the next, instead of creating a new pose, which would create a duplicate 
of the base pose, a new mesh was created from the last pose (Right click>New 
Mesh) and then sculpted outside of the Pose Morph tree. This same Pose Morph 
workflow was used to modify the base models of endothelial cells.

To animate the models, the Pose Morph mode was changed from Edit to 
Animate. The sliders were keyframed by pressing “Record Sliders” at desired 
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intervals of time and at the 
desired strength. For complex 
morphing, many slider 
strengths were keyframed 
to overlap one pose into the 
next (Figure 15).

As the cardiomyocytes 
first contract as isolated 
units and then as a whole, 
two methods of simulating 
contraction were used. As 
isolates, cardiomyocytes were animated to contract rhythmically along the Z axis, 
by scaling them from 1 to ~.9, while a Bulge deformer was increased in strength, 
from 0% to ~5%. For finer timing control, the keyframe spline Bezier curves were 
matched to cardiac patch force of contraction rates during stimulated pacing (Figure 
16). 

To animate the sheet of cardiomyocytes contracting synchronously, the Null 
containing all the cardiomyocytes was keyframed to scale with a Bulge deformer in a 
similar manner as described above. These keyframes were repeated for the scene.

Creating Materials in Cinema 4D
Sarcomeres can be observed within the cardiomyocytes #3-1, #3-2 (Table 1)

datasets (Figure 17). A drawing of sarcomeres based on electron micrograph data 
was created. The drawing was manipulated in Adobe Photoshop to create a seamless 
2048 x 2048 ppi pattern. A new material was then created in Cinema 4D. The 
drawing was loaded into the Material Alpha Channel (Alpha>Texture>Load 
Image) and in the Texture Tag, the Projection was changed from Spherical to 
Flat. By changing the viewport from Object mode to Texture mode, the axis of the 
texture tag was adjusted to align the sarcomere pattern with the longitudinal axis 
of the cardiomyocyte cell (Figure 18) This material was animated to contract by 

Figure 15. Pose Morph animation sliders.
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Figure 16. Animating cardiomyocytes to contract. (A) Stimulated pacing rate from 
tri-culture studies (data unpublished, Morrissette-McAlmon et al., 2018). (B) animated 
contraction (30 frames per second) F-stop curves were adjusted in Cinema 4D to match 
stimulated pacing rate of acutal cardiomyocytes.

B

A
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keyframing the Length U and Length V percentages in Cinema 4D.

A second material was created with a dark red in the color channel that provided 
a colored base under the Alpha material.

Animating in Cinema 4D
Interactions between hASCs, capillaries, and cardiomyocytes were created with 

the Collision and Smoothing deformers.

These two deformers were made children of the main hASC mesh. A section of 
the capillary object was identified for the hASC to collide around. Then, a Cylinder 
(Create>Object>Cylinder) was created and set into the same orientation as the 
section of the capillary object. The Cylinder was made invisible in the Viewport and 
dragged into the Collision Deformer Collider Object Field. Outside (Volume) was 
selected in the Solver tab. Additional hASC cell-cell interactions were animated 
through use of the Pose Morph tag as described previously. 

Interactive Illustration Content
An additional piece of illustrative content was created to demonstrate web-based 

interactivity within the animation. After review of the provided Principles of Tissue 

Engineering course materials, Cell Biology (Pollard, Earnshaw, Lippincott-Schwartz, 
Johnson, 3rd edition), and additional literature (Stoppel 2016), three illustrations 
were created on the subject of mechanobiology.

After review with preliminary sketches, the illustrations were scanned into 
Adobe Photoshop and adjusted into the final layout. This illustration was exported as 
a .png image and uploaded into a webpage.

Interactive Animation Creation and Website Development
The software TouchCast Studio was used to add interactivity to the animation. 

A new interactive video was first created on an Apple iPad Pro by entering the 
TouchCast Studio application and selecting Annotate a Video. The video, which 
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Figure 17. Sarcomere appearance of iPS cardiomyocytes (#3-1). Image credit: unpublished data 
from Allen Institute for Cell Science, a division of the Allen Institute.
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Figure 18. Sarcomere creation. (A) Electron micrograph of sarcomere (Bailey’s Textbook of 
Microscopic Anatomy). (B) Drawing of sarcomere. (C) Seamless sarcomere pattern created in 
Photoshop. (D) Pattern projection onto cardiomyocytes in Cinema 4D.

A

D

 B

 C

Object mode

Interactive Render Region
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was pre-rendered and uploaded to a cloud sharing service (Dropbox), was imported 
through the TouchCast Cloud importer. A new vApp was created (vApps>Add 
a vApp>Webpage). Webpage was chosen and a URL was loaded. This creates a 
vApp that hyperlinks to the webpage of choice, in this case, Stem Cell Orchestra: 
Mechanobiology webpage. This vApp was saved into the vApp tray.

To add the vApp to the animation, a new recording session was started 
(Click>Record). At the time indicated in the narration for interactivity, the 
recording was paused and the Mechanobiology webpage vApp was loaded into 
the video (Figure 19). After resuming play for about 15 seconds, the video was 
paused again and the vApp removed. The recording session resumed. At the end of 
the session, the new TouchCast interactive animation was uploaded to the user’s 
channel. The interactive video was then embedded into a webpage.

The website was developed through Wordpress with the Optimizer theme and 
the modular website building plugin, Page Builder by SiteOrigin.
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Figure 19. Interactive animation creation. TouchCast interactive video creation interface on Apple 
iPad Pro, with vApp placed in animation.
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RESULTS

Flowchart and Storyboards
A flowchart (Figure 20) was created to organize the content of the website into 

main topics, subtopics, and additional categories containing education material. User 
interaction with educational material is indicated. 

A set of storyboards (Figure 21.1-4) was created from selected pathways within 
the flowchart to define the user interface and website navigation. Numbers on the 
flowchart correspond to numbers on the storyboards. Selected sections include 
the following pages: (1) Stem Cell Orchestra homepage, (2) Heart Muscle topic 
navigation, (3) Stem Cell & Tissue Types interactive topic webpage, (4) interactive 
media webpage.

A detailed outline of the animation and interactivity (Figure 22) was created to 
indicate interactive content as reflected in the flowchart. 



34

PAGE INTENTIONALLY LEFT BLANK.
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Figure 20. W
ebsite flow

chart. N
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Figure 21.1-2. W
ebsite storyboards. 1) Stem
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epage. 2) C
licking of H
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Figure 21.3-4. W
ebsite storyboards. 1) Educational 

M
echanobiology resource. 2) Interactive M

edia w
ebpage 

w
ith interactive anim

ation (text not intended to be read).
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Figure 22. Detailed outline of animation and interactivity for the complete video of Building a 
Cardiac Patch.
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Cellular Animation
A script (Appendix B) and storyboards (Figures 23.1-27) were created following 

the detailed outline of the animation and interactivity. “Visuals” briefly describe the 
purpose behind the sketch and make note of motion not conveyed in the sketch. 
“Audio” was directly taken from the script and reformatted to align with multiple 
drawings. “Interactive Points” was derived from the detailed outline to present the 
interactive module title and briefly describe the proposed content, as well as show 
where the viewer would have to click on the screen to access interactive content.
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Figure 23.1. Animation storyboards 1-2.
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Figure 23.2. Animation storyboards 3-4.
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Figure 23.3. Animation storyboards 5-6.

Synchronized Contraction

Prevascularized
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Figure 23.4. Animation storyboards 7-8.

100 um
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Figure 23.5. Animation storyboards 9-10.

Fibrin Bioscaffold
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Figure 23.6. Animation storyboards 11-12. 
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Figure 23.7. Animation storyboards 13-14.

Take a Closer Look

at the Cardiac Patch
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Figure 23.8. Animation storyboards 15-16.
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Figure 23.9. Animation storyboards 17-18. 

Syringe Tip

Fibrinogen
Hydrogel
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Figure 23.10. Animation storyboards 19-20.

Aligned fibrin 
microsheet
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Figure 23.11. Animation storyboards 21-22.
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Figure 23.12. Animation storyboard 23.
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Figure 23.13. Animation storyboards 24-25.

Mylar frame
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Figure 23.14. Animation storyboards 26-27.

10 um
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Figure 23.15. Animation storyboards 28-29.

Nourishing Media     Aprotinin
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Figure 23.16. Animation storyboards 30-31.

Mechanobiology

Webpage

DAYS 4-7
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Figure 23.17. Animation storyboards 32-33.

Adherens Junction

Gap Junction



57

Figure 23.18. Animation storyboards 34-35. 

Gap Junction

Endothelial Cell hASC
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Figure 23.19. Animation storyboards 36-37.

Endothelial Cells
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Figure 23.20. Animation storyboards 38-39.
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Figure 23.21. Animation storyboards 40-41.
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Figure 23.22. Animation storyboards 42-43.
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Figure 23.23. Animation storyboards 44-45.
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Figure 23.24. Animation storyboards 46-47.
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Figure 23.25. Animation storyboards 48-49. 
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Figure 23.26. Animation storyboards 50-51. 
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Figure 23.27. Animation storyboard 52. 

52. Visuals: Title appears, circle graphic encircles heart with patch, links to additional 
content pop up, connected to circle.
  
 Audio: “To learn more about tissue engineering of cardiac patches, click any  
 of these buttons to explore the website.”
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Interactive Animation
A section of the storyboards was adapted and developed into an interactive 

animation (Figure 24.1-25). The animation shows: (1) theoretical surgical 
application of the patch on a heart, (2) macroscopic view of the fibrin bioscaffold, (3) 
seeding and stages of growth of cardiomyocytes, (4) cardiomyocyte intercalated disc 
formation and electrical conduction, (5) seeding and stages of growth of endothelial 
cells, (6) seeding and properties of hASCs, (7) additional properties of hASCs, and 
(8) macroscopic view of the completed patch on the fibrin bioscaffold. The learning 
module was integrated into a webpage on the final website.
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Figure 24.1. Animation still. Stem Cell Orchestra opening title.

Figure 24.2. Animation still. Corresponds to storyboard #24.
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Figure 24.3. Animation still. Corresponds to storyboard #25.

Figure 24.4. Animation still. Corresponds to storyboard #26.

  © 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder

  © 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder



70

Figure 24.5. Animation still. Corresponds to storyboard #27.

Figure 24.6. Animation still. Corresponds to storyboard #28.
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Figure 24.7. Animation still. Use of arrows to emphasize narration.

Figure 24.8. Animation still. Corresponds to storyboard #29.
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Figure 24.9 Animation still. Demonstrates interactive link to educational topic, corresponds to 
storyboard #30. Text not intended to be read.

Figure 24.10. Animation still. Corresponds to storyboard #31.
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Figure 24.11. Animation still. Corresponds to storyboard #32. Text not intended to be read.

Figure 24.12. Animation still. Corresponds to storyboard #33. Text not intended to be read.
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Figure 24.13. Animation still. Corresponds to storyboard #34. Text not intended to be read.

Figure 24.14. Animation still. Corresponds to storyboard #35.
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Figure 24.15. Animation still. Corresponds to storyboard #36.

Figure 24.16. Animation still. Corresponds to storyboard #37.
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Figure 24.17. Animation still. Corresponds to storyboard #38.

Figure 24.18. Animation still. Corresponds to storyboard #39.
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Figure 24.19. Animation still. Corresponds to storyboard #40.

Figure 24.20. Animation still. Corresponds to storyboard #41. Text not intended to be read.

  © 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder

  © 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder© 2018 Shawna Rose Snyder



78

Figure 24.21. Animation still. Demonstrates interactive link, corresponds to storyboard #42.

Figure 24.22. Animation still. Corresponds to storyboard #43.
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Figure 24.23. Animation still. Demonstrates interactive link, corresponds to storyboard #44.

Figure 24.24. Animation still. Macro view of the cardiac patch on Mylar frame.
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Figure 24.25. Animation still. Corresponds to storyboard #45.
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Mechanotransduction Illustration
A didactic illustration (Figure 25.1-3) was created to demonstrate web-based 

interactivity. The illustration teaches: (1) adult stem cell differentiation (2) a 
focal adhesion pathway, (3) how substrate stiffness influences tissue engineered 
cell constructs, and (4) how these concepts are important to cardiac regenerative 
medicine. 

Deployed Interactive Website
The website “Stem Cell Orchestra” was developed and launched as an interactive 

educational website. A set of icons (Figure 26) were developed to represent each 
topic within the Heart Muscle section. Within the Heart Muscle section, the module 
How to Build a Cardiac Patch was developed to demonstrate the navigation, user 
interface, educational benefits, and functionality of the web-based interactive 
animation. Screenshots of the website and interactive animation are shown (Figures 
27-30).

Figure 25.1. Mechanotransduction Illustration I. Dashed line indicates end of webpage.
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Figure 25. Mechanotransduction web illustration II-II. Continuation of previous illustration. Text 
not intended to be read.
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Figure 26. Icons developed for Heart Muscle navigation.

Stem Cells & Tissue Types

Vascularization Animal Models Implantation & Future 
Applications

Biological Signals Bioscaffolds



84

Figure 27. Stem Cell Orchestra homepage. Text not intended to be read.
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Figure 28. Stem Cell Orchestra website, Heart Muscle topic navigation and link to interactive 
animation. Text not intended to be read.
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Figure 29. Stem Cell Orchestra website, interactive media webpage. Text not intended to be 
read.
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Figure 30. Demonstration of timeline web interactivity. (A) Interactive link (orange outline added 
for clarity) in cellular animation timeline on Interactive Media homepage. (B) Clicking the interactive 
link takes the viewer to the Mechanobiology webpage, still within the cellular animation video player 
(orange outline added for clarity). Text not intended to be read.

A

B
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Access to Assets
The website created from this thesis is hosted online and can be accessed at 

www.stemcellorchestra.com. Please contact the author at srsnyderillustration@
gmail.com for more information or through the contact form on her website www.
srsnyderillustration.com. The author can also be contacted through the Department 
of Art as Applied to Medicine at Johns Hopkins University School of Medicine at 
http://medicalart.johnshopkins.edu/. 
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DISCUSSION

A Visual Solution to Teach Tissue Engineering
The primary goal of this project was to create an interactive didactic animation 

hosted on a web-based platform that introduces senior-year undergraduate students, 
and first-year Masters and PhD students to the topic of engineering a cardiac patch. 
The primary visualization, Building a Cardiac Patch, achieves this by showing the 
external and internal forces that drive cellular interactions and impulse conduction 
between cardiomyocytes with 3D models built from segmented volumetric datasets. 
Informal discussions with those who have taken the course, Fundamentals of Tissue 

Engineering, taught at Johns Hopkins University School of Medicine informed 
the content of this project. Survey questions can be found in Appendix A. The 
preliminary discussion and review of course materials detailed in the Introduction 
indicated that dynamic 3D visualizations presenting case examples of primary 
research would be beneficial material for students to access before, during and after 
the class. No such previously developed didactic tissue engineering research resource 
is known to the author. Suggestions from the graduate students were iteratively 
collected and incorporated into the design of the animation and website. 

Designing Stem Cell Orchestra began with a thorough literature review and survey 
of existing educational materials. Available print and online resources often depict 
cardiomyocyte interactions in flat, still images. Some primary research resources, 
such as “Maturing human pluripotent stem cell-derived cardiomyocytes in human 
engineered cardiac tissues,” (Radisic, Feric, 2016) contain confocal microscopy 
stills of cardiac tissue ultra-structure; others, such as Bailey’s Textbook of Microscopic 

Anatomy, (Kelly, Wood, Enders, 18th edition) depict the non-syncytial ventricular 
muscle through electron micrograph cross-sections. 

In order for tissue engineers to construct viable cardiac patches, they need a 
thorough understanding of the active, temporal forces at play within cellular culture. 
Cell fate decisions are ultimately induced by transient or permanent bioscaffold 
parameters that are controlled by the tissue engineer (Hartman 2016, Stoppel 2016, 
Liau 2016, Morrissette-McAlmon 2017). It is difficult to visualize this dynamic 
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setting due to the novelty of the tri-culture system and shortcomings of current 
visualization methods. Real-time imaging techniques such as confocal laser scanning 
microscopy can capture cellular events such as mitosis, but not cardiomyocyte 
contraction. When 3D image sets of fixed cells are visualized as a volume rendering, 
the cells are displayed only by their fluorescing antibody and the bioscaffold on 
which they are cultured is absent. These resources fail to depict the spatiotemporal 
cell-cell interactions that occur in a tri-culture system of a cardiac patch. 

An interactive animation platform was proposed to teach student audiences and 
provide a self-paced, in-depth look into examples of primary research. A website-
based interactive animation was chosen as the most appropriate educational media 
for depicting how to create this particular bioengineered model. As the interactive 
animation allows the user to be in control of their learning, review of supplemental 
educational materials can be customized to the learner’s experience level before 
they progress onto the next stage of the animation. Additionally, this web-based 
interactive animation is available for students to review at any time from any 
computer or mobile device.

Interactive Animation Development
By pre-rendering the Stem Cell Orchestra: Building a Cardiac Patch 3D animation 

and incorporating the interactivity within a separate application, the animation will 
stream on any device, dependent only on Internet access. 

Several aspects should be considered when designing an animation for timeline 
based interactivity. Adobe Animate (formerly Adobe Edge) uses a timeline and 
JavaScript to create web-based interactive vector graphics animations. Image 
sequences can be added to the timeline to create an animation on playback in a 
web browser. During initial technology background research for this project, a 
low resolution (72 dpi) image sequence of a 3D animation was added to an Adobe 
Animate project, JavaScript was added for interactivity, and the file was published to 
a web browser. Upon publishing, the image sequence is converted into a Spritesheet 
and added to the HTML file for playback. A significant reduction of speed was found 
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at 50 images, or a Spritesheet of 5.4MB. Adobe Animate also has the capability to 
progressively download a video from a web server, which allows videos to easily 
be embedded into a website. A new ActionScript file was created and a test 3D 
animation (FLV or F4V) was loaded. A preset user video playback interface was 
generated and the file was published to the desktop. However, the video playback 
controls are set and cannot be programmed for interactivity so the viewer cannot 
explore the website through the video timeline. Additionally, small, short duration 
videos can be embedded directly into the Animate document and can be published 
online as a part of the SWF file. This significantly increases the size of the published 
file and is only suitable for small videos less than 10 seconds in length. Given these 
drawbacks, it was determined that Adobe Animate was not a good fit for this project.

TouchCast is a smart video broadcast platform that allows viewers to interact 
with shared content without leaving the video stream. TouchCast is freely available 
to download and use on Apple iPad Pro and PC desktop computers (a Mackintosh 
desktop program is in development). Primarily used in live video broadcast, creators 
can quickly record, annotate live video and publish to a live stream. Or, users can 
upload pre-rendered video and annotate the video timeline with video apps (vApps) 
within the program to be published later for audience interactivity. Content includes 
web pages, photos, maps, twitter streams, headlines, photo galleries, video, and can 
be added anywhere in the video timeline and on the video screen. The creator has 
control over how long vApps are shown in the video, what size the vApp button is, 
and if a still thumbnail is shown or if there is immediate playback. Once annotated, 
the video is published to the creator’s TouchCast channel as an interactive video, 
with a link that can be embedded anywhere on the Internet. 

Once public, viewers can engage with annotated content within the video 
timeline, either by directly selecting the annotation within the video timeline or 
selecting the created hotspot within the video without leaving the video stream. 
Once selected, the content is displayed in full. The original video, which resides 
in the corner of the screen for the user to return to at any time, resumes playback 
from exactly where the user left off. This means a three-minute animation can 



92

be extended into a longer educational experience through the addition of didactic 
materials into key moments of the animation timeline.

Currently, TouchCast is being used for classroom education, major company 
communications (BBC, Pfizer), and personal video creation. To the author’s 
knowledge, this is the first instance of TouchCast interactive video being used to 
create biomedical education materials. 

Data Segmentation and 3D modeling 
The confocal microscopy datasets available for this project were taken with a 

low objective (5x to 20x), and while fluorescent labels show some structures (nuclei, 
gap junctions, etc.) other structures remained invisible (ASCs, fibrin bioscaffold). 
First FIJI, then Imaris were used to manually segment areas of the cellular data 
from available datasets. Additional resources from the Allen Institute of Cell Science 
and Louch Lab at the University of Oslo offered higher objective images (63x). For 
example, the appearance of sarcomeres was needed within the cardiomyocytes. 
Sarcomeres are arranged end to end into long, rod-shaped myofibrils that run the 
length of the cell. They have a striated appearance due to the overlapping nature 
of thin and thick filaments within an individual the myofibril, which make up the 
contractile apparatus of striated muscle cells.

For this project, confocal microscopy datasets acquired at the 40-63x 
magnification were utilized for visualizing 5-30µm cellular structural data. 
Segmented t-tubule data was used to reconstruct an additional single cardiomyocyte, 
which provided reference data for depicting the final elongated cardiomyocytes. 

Future Development of the Website
A novel workflow for the production of an interactive, didactic, data-driven 

animation depicting a bioengineered tissue construct was developed. Newly 
developed materials can be incorporated into the website. Future development 
could focus on flipped-classroom instructor videos, and space for researchers to 
actively contribute research and publications. The described workflow, 3D modeling 
techniques, and interactivity software could also be applicable to the production of 
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didactic animations of other biomedical subject matter and may be adapted for other 
audiences to offer alternative didactic resources.

Future Applications of This Technology
Scientific animations are a potential source of insight and research dissemination; 

however, it can be difficult to determine the degree to which visualizations 
are informed by scientific evidence (Jantzen 2015). In peer-reviewed scientific 
publications, there is an established system of citation, which is difficult to replicate 
in scientific animation, as there is no way to link references to individual features 
of the display. Even when animations include a bibliography in the end credits, it is 
up to the viewer to examine references and make assumptions as to where and how 
they were used to inform the work, which leads to a lack of clarity regarding the 
credibility of scientific animation (Jantzen 2015).

With this technology, 3D models within scientific animations can be annotated 
with citations. As a 3D model is shown, a link can be established to an image, 
webpage, even a peer-reviewed journal article, that shows the reference material 
from which the 3D model was derived from. This would be informative in molecular 
animations derived from the Protein Databank, or in cellular animation that uses 
particular datasets. Future investigations are needed to demonstrate how this 
technology can best clarify scientific animations.
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CONCLUSION

Teaching temporal cellular dynamics and cell-cell interactions is challenging 
due to the difficulty of obtaining real-time datasets over a long culture time. By 
combining the newest tri-culture method, cutting edge interactive video, and a 
review of cellular datasets, a web-based “Stem Cell Orchestra” was created. Future 
work can be done to incorporate primary research into the website and produce 
interactive, data-derived visualizations of cellular interactions. 

Lastly, a novel workflow for creation of data-driven cellular 3D animation 
supplemented with educational cellular study materials in an interactive video 
timeline was developed to visualize the development of a cardiac patch as a model 
bioengineered tissue. This workflow can be expanded to encompass any type of 
bioengineered tissue, as it describes teaching needs assessment, data segmentation, 
3D modeling and animation with web-based interactivity. 

The novel integration of web-based resources with didactic animation in teaching 
bioengineering concepts fills the gap in educational resources available for biomedical 
engineering students. This project lays the foundation for the complete development 
of the Stem Cell Orchestra website and a series of animations for tissue engineering 
research. This innovative approach provides a powerful new workflow that can be 
used in multi-disciplinary scientific and biological visual communication projects. 
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APPENDIX A

1.	Were you familiar with any tissue engineering concepts before this class? If so, 
what undergrad courses or lab experience introduced you to these concepts?

2.	Have you ever cultured cells before? Y/N 

3.	What specific topic of tissue engineering were you most interested in learning 
about? What was the moment you decided you wanted to pursue this field? 

4.	Were there any unclear topics or lectures throughout the course? Or, were any 
topics particularly difficult to understand?

5.	Was any content about engineering tissue constructs particularly memorable? 
What was not clear?

6.	Would an animation of cell growth clarify the importance of vasculogenesis in 
large tissue constructs?

7.	What concepts did you research outside of class? Did you find any 
supplemental websites for teaching tissue engineering concepts?

8.	We are considering developing a visual teaching tool to help students learn this 
subject. What type of visualization would you like to help better understand 
the material? Please rank the following:

a.	Schematics and drawings

b.	2D animation with narration

c.	3D animation with narration interactive 3D models (click structures 
on and off)

d.	ability to rotate and manipulate a model, show models change over 
time, ability to zoom in and out. 

9.	Which would you most like to see animated?

a.	Cell-cell interactions
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b.	Cell growth on specific substrates

c.	Vascularization of tissue

10. Do you think a resource that teaches components of tissue engineering 
through a visual case example would be useful for students of this class? How much 
time would you spend outside of class using it?

11. Is there anything that we haven’t mentioned that you would like to add?
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APPENDIX B

Stem Cell Orchestra Script

Cardiomyocytes

To create a cardiac patch, various cell types are seeded on to a fibrin bioscaffold 
which is wrapped around a Mylar frame and approximately 300 microns thick. 

A droplet of solution is placed on the fibrin. 

The solution contains cardiomyocytes, which attach to the fibrin bioscaffold. 

The cells are immersed in solution that contains nourishing media and Aprotinin, 
which inhibits break down of the fibrin bioscaffold.

The solution is refreshed every other day as the cardiomyocytes elongate guided 
by the parallel alignment of the fibrin bioscaffold. Click to learn more about how 
bioscaffolds influence cell growth. 

Between days 4 to 7, the cardiomyocytes begin to spontaneously contract. 

Binding sites called adherens junctions form structural connections between 
adjacent cardiomyocytes. These sites develop into intercalated discs. 

Gap junctions that also form at the intercalated disc allow electrical signal 
propagation between cardiomyocytes, facilitating synchronized contraction.

Vascularization.

After 14 days, a four to one ratio of endothelial cells and human adipose derived 
stem cells, or hASCs, are seeded onto the cardiomyocytes to start the growth of the 
blood vessels. 

Refreshed every other day with a composite of stem cell and endothelial growth 
media, the endothelial cells elongate and undergo vasculogenesis to form new blood 
vessels. 

The cells elongate into multicellular cords. Intercellular vacuoles unify to create a 
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hollow lumen. 

Stem Cell Support

The hASCs are mesenchymal stem cells. They can mimic perivascular cells by 
stabilizing the endothelial vessels. 

The hASCs also mimic fibroblast cells by secreting an extracellular matrix that 
envelopes the endothelial vessels and cardiomyocytes. 

New research results suggest that hASCs may form gap junctions with 
cardiomyocytes and contribute to contraction. 

hASCs may also promote angiogenesis by secreting paracrine signaling factors 
such as VEGF, FGF, and bFGF. 

They also secrete exosomes, or vesicles filled with growth factors and microRNA, 
the effects of which are still unknown. 

These carefully orchestrated interactions between endothelial cells, hASCs, 
and cardiomyocytes form new functional tissue. The complete vascularized cardiac 
patch is able to integrate with native heart tissue and support heart function after 
myocardial infarction.
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